
Monitoring Portfolios in Real Time
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Use the Portfolio View display to monitor your portfolio holdings in real time, displaying data such as price, percent change, and intra-day contribution on an absolute and/or relative 
basis.  You can also view dynamically changing charts for your portfolio and/or benchmark at the security or group level.

Right-click in Portfolio View and 
select “View” to display a chart. 

Right-click in a Groups chart and 
select “Groupings” to change 
the grouping classification.

Double-click on a column 
heading to sort by that column.

Right-click and select “Options” 
to group your portfolio.

Click on the News Count to see 
a breakdown of the news by 
source.

Click the Lookup button 
to select a portfolio and/or 
benchmark.  

Right-click in the chart and 
select “Data Item” to change the 
metric being charted. 

Right-click in the chart and 
select “# of Display Bars” to 
change the number of bars 
shown in the chart.

Double-click a bar to view news 
stories for the security
in a News display.

Right-click and select “Options” 
to customize your columns 
using data from your FactSet 
subscription or your proprietary 
data.

Right-click on a column and 
select “Group Statistics” 
or “Total Row” to calculate 
statistics at the group and 
portfolio levels.  

Right-click and select “Chart 
Options” to select what charts 
to display. You can display up 
to six charts, choosing from 
the following chart types: 
Portfolio Performance, Groups, 
Constituents, Heatmap, and 
Intraday History.  



Viewing the Attribution Report in Portfolio Analysis
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Portfolio Analysis reports deliver insight into the factors that make up your portfolio and illustrate how your investment decisions affect performance. The Attribution report provides in-
depth analysis of your portfolio’s return relative to your target benchmark. For a guided tour covering the basics of Portfolio Analysis, launch the eLearning demo on Online Assistant 
page 13409.

Click the Lookup button 
to specify your portfolio 
and benchmark.

Click the quick links to edit 
specific report settings 
(e.g., report currency and 
economic sector).

Use the Attribution report 
to analyze the effects of 
portfolio management 
decisions including 
allocation, security 
selection, and interaction.

Click the Options button to access all of your report specifications 
in one centralized location (e.g., portfolio/benchmark, report 
dates, groupings, and exclusions).  For more information on the 
Options dialog box, see Online Assistant page 8835.

View the portion of 
portfolio excess return 
attributable to taking 
different group bets 
than the benchmark 
with allocation effect.

Right-click on a 
column or row to 
access additional 
report options. 
Select the “Column 
Help” option to see a 
textual definition and 
calculation for the 
column.

Click the Trade Simulation button to simulate 
trades in order to determine the impact your trades 
may have on your portfolio’s performance and 
composition.  For more information on simulating 
trades, see Online Assistant page 12800.



Click the Add Report button and select a 
template to create custom reports and have 
them saved in the left pane of the application.

You can select up to 17 
partial duration points using 
the Fixed Income tab in the 
Portfolio Analysis Options 
dialog box.

Include partial durations 
to view interest rate 
sensitivity for your 
portfolio and benchmark 
to specific points of the 
yield curve (e.g., one-year, 
five-year, and ten-year).

View interest rate sensitivity at the sector level and 
at the total portfolio level. 

In addition to sector groupings, you can also group 
your report by credit rating, OAS, convexity, and 
years to maturity, for example.

Analyzing Fixed Income Portfolio Performance

(33)support@factset.com Copyright © 2010 FactSet Research Systems Inc. All rights reserved.

14644FactSet Insert menu > Portfolio > Portfolio Analysis

Online Assistant Page IDWhere can I find this on FactSet?

Analyze the performance of your fixed income portfolios by creating custom reports in Portfolio Analysis. For example, you can create a Partial Durations report to measure the percent 
change in a bond’s price given a shock in the yield curve at a specific point. Partial durations quantify sensitivities to changes in specific parts of the yield curve. For a guided tour covering 
the basics of Fixed Income Portfolio Analysis, launch the eLearning series on Online Assistant page 15671. 



Charting in Portfolio Analysis

Click the Add Chart button to view 
or create a new chart. Default charts 
are also available. 

Click the Chart Layout button 
to specify how you want to view 
charts (e.g., report and chart 
side-by-side or more than one 
chart at a time). 

To edit a chart element, 
right-click the element 
(e.g., column) and then 
select from the available 
customization options.

To print or preview a 
chart, click the Chart 
Options button.

To dynamically adjust 
chart data, click the Chart 
Options button and 
select the “Interactive 
Mode” option.
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Portfolio Analysis lets you chart portfolio and benchmark values to give you a graphical snapshot of performance.  Portfolio Analysis offers several predefined charts, but also lets you 
manipulate charts to meet your needs.  For a guided tour covering the basics of creating charts in Portfolio Analysis, launch the eLearning course on Online Assistant page 16098. 
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Using Portfolio Dashboard

Click the Settings button to access report 
customization options, such as specifying 
your universe, adding predefined columns, 
and creating custom columns.  For more 
information on the Settings button, see 
Online Assistant page 14183.

Click the Add button to add accounts and 
holdings-based or returns-based portfolios 
to your report.

Double-click any value to launch the 
corresponding report in Portfolio Analysis 
or SPAR. 

For example, double-clicking the Absolute 
Total Return column for U.S. Large Cap 
Core takes you to the Contribution report 
in Portfolio Analysis. Here you can see how 
the total return value -0.43 was calculated.  

Click the Alerts button to create alerts and stay 
up-to-date on portfolio values’ movements.
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Use Portfolio Dashboard to monitor up to 50 portfolios at once in a single report. You can view bottom-up performance and predictive, factor-based risk along with top-down returns-
based performance. To perform deeper analysis on a specific portfolio, you can easily jump to Portfolio Analysis or SPAR.  For a guided tour covering the basics of Portfolio Dashboard, 
launch the eLearning series on Online Assistant page 16255. 



Using Portfolio Springboard
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Use Portfolio Springboard to view the most common holdings-based (e.g., weights, characteristics, and performance attribution), returns-based (e.g., style, historical risk, and peer 
universe), and predictive risk analysis in one report. 

Click the Options button 
to modify your report (e.g., 
database sources used or 
report currency).

Click the Download 
button to download the 
report locally to your PC as 
a PDF or a Microsoft Word 
document. 

For more in-depth analysis, 
click any summary link to 
launch the corresponding 
Portfolio Analysis report, 
Company Snapshot, or 
SPAR report.

To access additional 
custom report/chart 
options, right-click the 
report or chart.

To learn more about 
a company, click the 
company name link to 
launch the corresponding 
Company Snapshot report.

Click the Open button to 
open a previously saved 
document, which includes 
your report settings. 



Using Alpha Testing
Use Alpha Testing to analyze the relationship between multiple variables and the resulting investment returns over time. Set up models using only the companies, factors, and time 
frames that you need to test your ideas.  For a guided tour on building models and analyzing results in Alpha Testing, launch the eLearning courses on Online Assistant pages 13209  
and 13890.

View your results in
highly customizable, easy-
to-understand reports.

Double-click a column 
header to sort results by
that column.

Group your results by
factors, groups within
factors (i.e., fractiles),
periods, or any
combination of these.

Choose from Equal
Weighted, Cumulative,
Annualized, and other
return types to apply to
any or all of your reports.  
For more information on 
the return types available, 
see Online Assistant 
page 13599.

Add charts to display your results in chart form 
or build your own custom chart within any Alpha 
Testing document.  To learn more about charting 
model results, see Online Assistant page 14198.

Add, remove, change, or reformat 
any column in any report to suit 
your model’s outputs.

Right-click above the toolbar 
buttons to access additional 
choices, such as editing and 
formatting options.

Watch for Alpha Testing’s new look -- coming soon!

(37)support@factset.com Copyright © 2010 FactSet Research Systems Inc. All rights reserved.

13551FactSet Insert menu > Quantitative > Alpha Testing 

Online Assistant Page IDWhere can I find this on FactSet?



Using Northfield Portfolio Optimizer
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Use Northfield Portfolio Optimizer to determine trades that will maximize your portfolio’s utility and reduce its risk relative to its benchmark. You can use any screen, portfolio, third party 
benchmark, or your own custom variables to set inputs and constraints in creating problems for the optimizer to solve.

Click the Optimization button to set 
precision, tracking error, long and short 
constraints, asset weights, and more 
constraints that will determine trades 
made during the optimization process.

Click the Model button to specify 
model basics such as the portfolio, 
benchmark, buy lists, asset type 
adjustments, dates, and prices. Click any Lookup button 

to reference existing data 
or create a custom formula 
using all the data available 
from FactSet to calculate your 
optimization variables.

View model results in one of over 
twenty reports that describe your 
optimal portfolio.



Analyzing a Portfolio’s Style, Performance, and Risk
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SPAR (Style, Performance, and Risk) lets you analyze your portfolio’s performance against 20,000 equity and fixed income benchmarks. Dynamically create presentations of your 
portfolio’s style, performance, risk, and peer group analysis, which you can easily download to Microsoft PowerPoint.

Analyze any portfolio or 
combination of portfolios
against a specified
benchmark.

Use the FactSet default
presentation, or customize 
your own presentation 
by clicking the Manage and 
New Slide buttons.

Set options specific to
your charts and reports,
including dates, statistics,
style sets, and universes.

Insert any number of charts 
and reports into a slide.

Create custom universes
and screen for funds in
Fund Screening. See
Online Assistant page 13945
for more information.

Right-click a chart or
report to set report
options such as date
range, colors, chart type,
and more.

Drag and drop charts into
the chart viewing area.  If 
you do not see the chart 
selection pane, right-click in 
the gray area at the top of the 
application (i.e., to the right 
of the Fund Screening button) 
and go to View > Toolbars > 
Chart/Report List.



Managing Databases Using Data Central
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Use Data Central to view, edit, and upload your proprietary data to a PRT or OFDB database.  PRT databases capture a single point in time. OFDB databases can capture a single point in 
time or multiple dates.    

Click the Open button 
to view a proprietary 
database that was 
uploaded to FactSet.

Select whether to view your OFDB 
database by date or by symbol from 
the View By drop-down menu.

Click the Upload Wizard button to create 
and upload databases.  The Upload Wizard 
will guide you through the process.

Double-click a column 
heading to sort by the 
selected column.

Click the Split button to view 
split-adjusted data. Click Unsplit 
to view unadjusted data.

Click the Record buttons 
to add, edit, or delete a 
record in the database.

Right-click in the gray 
area at the top of the 
component to view the 
Data Central menus, 
which allow you to 
access File Manager 
and additional options.



Managing Databases Using Quick Portfolio
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Use Quick Portfolio to view, edit, and quickly upload your proprietary data to an OFDB database.  Once you’ve uploaded your data, you can use it in custom reports, Data Downloading, 
Screening, and Portfolio Analysis.  For a guided tour covering how to create portfolios and identifier lists in Quick Portfolio, launch the eLearning series on Online Assistant page 14904.  

Click the “Modify Settings” link to 
specify index and sorting options.  

Index options let you modify 
characteristics such as index 
methodology and weighting scheme 
for custom indices, which can be 
used in other applications.  See 
Online Assistant page 13980 for more 
information.

Enter identifiers in the Enter Symbols 
text box to create a ticker list. To 
enter multiple identifiers, enter a 
space between each identifier.

Copy proprietary data from Microsoft 
Excel into Quick Portfolio.  Press 
CTRL+C to copy the data in Excel and 
CTRL+V to paste the data in Quick 
Portfolio.

Click New File to create a new 
database.

Click Save to save the database.

Select a holdings date for your data. 
Select “None” for non-time series 
databases.  If you’re uploading a 
Date field, “From DATE Field” will be 
selected as the holdings date.

Click Clear Data to clear all the 
identifiers and data in the view. 
The headings for defined fields will 
remain.  To delete only a security 
and its corresponding data, select 
the identifier (or multiple identifiers) 
and then click Remove. 

Click “Add Field” to define a new 
field. You can select a predefined 
field or create a custom field.



Using Portfolio Viewer
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After uploading your proprietary data to FactSet, you must add the file to Portfolio Viewer in order to analyze the portfolio, custom composite, or benchmark in applications such as 
Portfolio Analysis and SPAR. You can also use Portfolio Viewer to add a corresponding benchmark, inception date, and target risk model. 

Choose the Composite Assets tab to 
construct a composite asset portfolio by 
using an identifier as  a weighted basket 
of securities.  See Online Assistant page 
12556 for more information.

Choose the Asset Types tab to 
map your portfolio assets to 
asset types available in FactSet 
(e.g., Futures or Options).  See 
Online Assistant page 14078 for 
more information.

Choose the Parser Logs tab to 
monitor your portfolio’s holdings 
and/or returns upload process 
in the new FactSet.  See Online 
Assistant page 11533 for more 
information.

Choose the Reconciliation 
tab to view production 
reports and set up alerts 
to monitor potential 
problems with data 
you upload.  See Online 
Assistant page 14868 for 
more information.

Select the type 
of portfolios you 
want to view 
(e.g., holdings or 
returns) from the 
By Type drop-
down menu.

Expand and view 
the components 
of a custom 
composite.

Right-click on any row to 
access portfolio options.

Choose the FI Logs and FI Settings tabs to 
specify important information for Fixed Income 
Portfolio Analysis regarding production jobs and 
calculation settings.  See Online Assistant page 
14762 for more information.



Viewing Economic Events 
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Use the Economic Events Calendar to view real-time events for approximately 750 indicators in 24 countries and regions. View important events and details including the indicator 
covered, the period covered in the release, the forecasted or actual figures, and the market median forecast.

Click the column 
headers to sort the 
calendar based on 
the selected item.

View the most recent  
data or forecast for  
the indicator.

Click an event headline  
to open the right pane  
and view options for  
more detail.

Select an Event or 
Indicator type to filter 
the results.

Further refine results
by selecting the locales 
to display.

Click the links to view a 10-
year chart of the selected 
indicator, a detailed 
economic report, or related 
press releases.

Search for a specific 
company identifier, or 
toggle between transcript, 
conference, or economic 
event information.

Click the buttons to 
print or download event 
information, and access 
additional help for  
the calendar.

Click the event name  
to open a more  
detailed description.



Charting Economic Series

(44)support@factset.com Copyright © 2010 FactSet Research Systems Inc. All rights reserved.

13155FactSet Insert menu > Charting > Economic Analysis Charting

Online Assistant Page IDWhere can I find this on FactSet?

Use Economic Analysis’s charting and report-writing options to analyze markets. Create charts or reports for any combination of economic and corporate fundamental time series. View 
important economic events and related details within minutes of their release.  For a guided tour of charting in Economic Analysis, launch the eLearning series on Online Assistant 
page 13704.

Change the chart’s time 
period by selecting a period 
from the Start Date drop-
down menu, or by clicking 
the Options button and 
selecting the Period tab.

Select a series by category.

Click the Report button 
to view the chart’s 
corresponding report.

Click the Filters button 
or right-click on a column 
header to narrow your 
search results based 
on country, database, 
frequency, or data source.

Limit your searches  
by category.

Right-click a column in the 
Preview pane to apply series 
math and transformations.



Viewing Economic Reports
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Launch Economic Reports to view reports that list important economic indicators for more than 60 countries. These reports let you view dozens of important economic indicators with a 
single mouse click.

Click the Lookup button to 
browse for an economic series or 
type it into the series form.

Select a row and then click the 
Info button               for more 
information about that indicator.

Select a different frequency from 
the drop-down menu. Economic 
Reports can also feature 
Transformation and Seasonal 
Adjustment options.

Click the source 
link to change your 
database order.

Change the report’s 
history or generate 
a chart using the 
Calendar and 
Chart buttons.



Viewing Index Data

(46)support@factset.com Copyright © 2010 FactSet Research Systems Inc. All rights reserved.

15890FactSet Insert menu > Markets > Indices

Online Assistant Page IDWhere can I find this on FactSet?

The Indices category allows you to view real-time data for major indices, as well as create constituent-level reports and country and industry breakdowns for a variety of benchmark 
families. In addition to the reports shown here, you can also access the Matrix and the Performance & Valuation reports in the Indices category.

Use the Constituents report to 
view constituent-level data for a 
broad array of index families and 
groupings.

Use expand/collapse 
functionality for your 
different grouping levels.

Instantly send equity or 
fixed income indices to the 
Equity Screening or Debt 
Screening applications for 
further analysis.

Double-click on an index 
to display its key statistics 
and constituents.

Select from three chart options 
in the Index Breakdown report: 
Actual, Indexed, and Multi-
Horizon.

Add or remove data columns from 
your report, and change the date.

View real-time data for 
major global indices in 
Market Watch.

Right-click on any index to 
access FactSet’s proprietary 
performance, estimate, 
growth, and valuation data in 
the Full Quote display.



Using Equity Screening
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Universal Screening’s Equity view allows you to test and confirm investment strategies across all databases simultaneously.  You can screen on your own investable universe or on tens of 
thousands of securities worldwide.  FactSet has a vast library of predefined items and you can also develop your own proprietary screening criteria using any data available.  For a guided 
tour covering the basics of Universal Screening, launch the eLearning series on Online Assistant page 16208.

Click the Open button to access 
your saved reports.

Use “type-ahead” functionality 
in the Universe Limitation 
field or click the Limit button 
to construct a universe of 
securities defined by one or 
more limitations.  You can limit 
your screen based on a number 
of factors, both qualitative and 
quantitative.

Select the Format drop-
down menu to apply 
groupings, sort by security 
and groupings, apply multi-
factor ranking, and more.

Click the Report button to 
display the securities that 
meet your criteria.

Click the Equity, Debt, 
Holder, or Fund buttons to 
change your report type in 
Universal Screening.

Tip:  To save the list of securities that pass 
your screen to a portfolio, OFDB file, or online 
spreadsheet report, click the Output Options 
button         and select “Archive Screen Results.” 
See Online Assistant page 16108 for more details on 
archiving data. 

Click the Screen Dashboard button to access 
sample screens to serve as building blocks 
when creating your own custom screens.



Limiting the Universe
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Use Universe Builder to construct a “universe” of securities defined by one or more limitations. Limitations are grouped on category tabs by industry, index, geography, security type, 
exchange, and database.  Click the Limit button in Screening to launch the Universe Builder.

Select Preferences to 
modify the category tabs, 
include all dually-listed U.S./
Canadian securities and all 
Cash identifiers, and exclude 
inactive securities, secondary 
listings, and non-equity 
securities.

To select the entire contents 
of a folder, select the row 
containing the folder. To 
select a limitation within a  
folder, select the folder, then 
click the Expand button.

Choose the Custom tab to limit 
your universe using a FactSet 
formula.  For example, you 
can use an ISON formula to 
limit your screen to benchmark 
constituents on a specific date.

Click the Include button to limit 
the universe to that selection or 
the Exclude button to limit the 
universe to everything except 
that selection.  The universe 
limitation(s) will appear in the 
Current Limitations list below.

Click the Preview button to 
display a list of securities that 
pass your current limitations.

Click the Logic button to modify 
the logical relationships between 
your universe limitations.

Define your universe by 
selecting universe limitations 
from the category tabs.  See 
Online Assistant page 12888 
for more information on each 
category.

Tip:  You can also use “type ahead” searching within the Universe 
Limitation search bar to limit your universe. Potential matches to your 
search term will be returned from the Industry, Index, Geography, and 
Exchange tabs of Universe Builder. For more information about this 
functionality, see Online Assistant page 14858.



Creating and Editing Parameters
Click the Formula Lookup button           to create parameters in your screening report. Formula Lookup is a utility that helps you find formulas in FactSet’s formula libraries, as well as 
create and edit your own formulas.  

1.  Click the Formula Lookup 
button to search for a formula. You 
can also edit, delete, move, and 
change parameter settings in the 
Parameters section.

4.  Search for and select a formula.  
After you select a formula, enter 
formula arguments to the right.

2.  Click the Sources button to 
choose a specific data source. In this 
example, the FactSet Fundamentals 
formula library is selected.

You can edit your parameters 
to add relational operators and 
compare one formula to another.  
To edit formulas, click on the 
formula in the Workspace, then 
make your changes. 

In this example, the parameter will 
return all securities whose annual 
total debt is less than 95% of the 
previous year’s annual total debt.  

3.  Click the Information button to 
view a detailed description of the 
selected data source.

5.  Click the Add Selected button 
to include the formula in your 
Workspace.

6.  Click the OK button to add the 
new parameter to your report.
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Screening for Ideas

View your search criteria results.

Choose your report type 
(companies, M&A deals, new 
issues, etc.).

Click the Open button to open 
a saved screen.

Click the View Results button 
to launch the Screening Results 
tab, which displays companies 
that passed your screen along 
with your screening criteria and 
relevant data.

Add your search criteria.  The 
criteria available depends on the 
report type you select.

Watch for the new version of Idea Screening -- coming soon!

After choosing the report type, 
you can select premade screens 
available in the Quick Screens 
section.
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Use Idea Screening to screen on companies (public and/or private), M&A deals, M&A league tables/volume totals, private placements, new issues, and private equities based on your own 
criteria.  With Idea Screening you can generate ideas, build new comp lists, or screen for deals and IPOs of potential interest.



Charting Market Data
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Use the Chart display to chart company-specific market data over different frequencies. You can also create indexed and relative price charts to perform company vs. benchmark 
comparisons.

Click the Profile button 
to access default FactSet 
charts or your custom 
chart profiles.

Right-click on the chart 
and select “Drawings” 
to add trendlines and 
Fibonacci retracements.

Double-click on the chart to launch 
a News display with stories from the 
corresponding date.

Click on an annotation to 
view the historical/detailed 
report or corresponding 
news document. 

Click the Period button to select a 
predefined chart period. 

Click the Chart Options button to 
customize the chart.

Choose a tab to customize the chart:
Options +  - To change formatting such 
as chart type and period.
Upper Indicators +  - To add upper 
indicators such as moving averages 
and annotations. 
Lower Indicators +  - To add lower 
indicators such as MACD and 
momentum.
Multiple Identifiers  + - To create an 
indexed or relative chart. 
Lines and Highlights +  - To add 
relevant fundamental items or 
proprietary data. 



Add additional identifiers in the 
Compare To dialog box. To select 
dynamic default benchmarks, click 
the Lookup button and select 
from the available index families.

Charting Interactively

Click the Lookup button         to 
search for identifiers. 

To change or add a series, right-
click on the chart area and select 
the “Add Series” option. 

Add crosshairs, trackballs, 
and trendlines using the 
buttons below the chart.

To modify the up/down color 
scheme, crosshair cursor 
type, and other settings such 
as calendar and currency, 
click the Settings button.

To toggle between indexed 
or relative charts, click the 
Index and Relative buttons.

To add dynamic annotations such as corporate 
actions, insider trading, and M&A activity to your 
chart, right-click on the series and select the 
“Annotations” option.

Click the Add Plot button to add 
additional plots to your chart. To 
clear or delete plots, right-click 
on the chart area and select the 
“Plot” option.
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Use Interactive Charting to create flexible charts depicting company and non-company data. Predefined series include pricing, financial, estimate, and valuation data. For a guided tour 
covering the basics of Interactive Charting, launch the eLearning series on Online Assistant page 16214. 



Charting Financial Data Using Quick Charts
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Quick Charts offers access to the most relevant financial series to chart as well as options frequently associated with the series.  These options include moving averages, annotations, 
price overlay, economic indicators, and more.  To view the formulas used for the charts, see Online Assistant page 13562.

Click the Print button to 
print your report.

Click the Plot Arrow buttons 
to change your display and 
view up to four charts at once.

Click the Options button to 
configure the settings and 
annotations for a given series.

Select a chart type.  Then, 
select a series to display in 
each chart area.

Click the Help button to 
launch application-specific 
documentation for the 
report you are viewing.

Add annotations to your 
charts (e.g., M&A deals).  
After adding annotations to 
the chart, hover your cursor 
over an annotation to view a 
pop-up showing details.

Right-click on the chart 
to export it to Chart 
Center or copy it as an 
ActiveGraph.
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The Web Browser display allows you to integrate your browser into FactSet.  You can view company homepages and any public websites.  You can also customize the available website 
links to meet your needs. For example, you can configure the Web Browser to automatically enter a company identifier in your favorite internal or external research sites.

Select “Web Address” 
from the drop-down 
menu and enter the 
URL of a website you 
wish to view. 

Click the Back and Forward buttons to 
navigate back to the previous page or 
forward to the next page in the history.

Select “Company Homepage” from the 
drop-down menu and enter an identifier. 
By default, when you enter an identifier, 
the company’s homepage will display.

Create a custom tab that includes all of 
the websites that you frequent.

To find a security 
identifier, click the 
Lookup button.
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Use FactSet Wireless Plus to view your FactSet watch lists, current news, and historical price charts on your mobile device. View a wide array of company reports, including but not limited 
to: Ownership, Deal Activity, Intraday Price Charts, Detailed Price Quotes, and Capitalization.

Access your wireless-enabled watchlist.Chart prices for an individual security, or 
compare the performance of multiple securities.

Click a column heading 
to sort the columns 
(once for ascending, 
twice for descending, 
three times for original 
order).

Navigate using the scroll 
wheel or trackball to select 
company reports for a 
detailed quote, intraday chart, 
estimates, and more.

spacebar Page Down

escape Back

T Top of grid or list

B Bottom of grid or list

Q Launch Quick Quote

U Put focus in Universe box

H Hide Application

R Force Data Refresh

O Open Reports

P Open Portfolios

W Open Watchlists

M Open Markets

N Open News

C Open Charting

I Open Research Tools

E Open Event Calendar

Navigate FactSet Wireless Plus 
using Hot Keys:

Data is cached from 
the last update, and 
available in areas 
with limited network 
coverage. A “D” 
denotes a delayed 
intraday price; an “E” 
denotes the previous 
day’s end-of-day price.

Click the News icon to 
access a consolidated 
view of the market 
stories from Dow 
Jones or find news on 
a specific company 
using the Identifier 
and Keyword boxes.  
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Setting up wireless access on FactSet is quick and easy.

1. Go to FactSet Insert menu > 
Utilities > Wireless Configuration 
to enable wireless.  (Or right-click 
in a Portfolio View or Market 
Watch display and go to Wireless 
> Configure Wireless.) 3. Create a password that  

contains a capital letter, a 
number, and is eight or more 
characters total.

The indicator will turn green 
once you have enabled wireless 
access.

From the browser on your mobile device, go to:  http://www.factset.com/wireless/wp.html1. 
When prompted, click 2. Download.
Once the installation is complete, click 3. Run to start the application, or OK to return to the home screen.
To launch Wireless from the home screen, locate and select the blue icon      . (Depending on your mobile device 4. 
and IT policy, this could be located on the home screen, or in a “Downloads” or “Applications” folder.)
Once launched, you will be prompted to log in.5. 
Enter your FactSet username and serial number, along with the wireless password you set during the 6. 
configuration process.
Click 7. Login to launch FactSet Wireless Plus.

For additional installation options, including internal deployments and desktop loading, see Online Assistant page 15641.

2. Click the “Set Now” hyperlink 
to set your password.

To install FactSet Wireless Plus on your mobile device:
Tip:  To make a new portfolio or watchlist 
available on your handheld device, click the 
“+ Enable New File” hyperlink.  For more 
information, see Online Assistant page 14889.
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=FDS is a Microsoft Excel function that dynamically pulls data stored on FactSet servers, allowing you to automatically update your spreadsheet data when needed.  To learn more about 
using =FDS codes, launch the eLearning course on Online Assistant page 13610.

Allows FactSet data to be dynamically incorporated into an Excel model +
Uses Excel functionality, such as cell referencing +
Allows you to combine FactSet formulas with other Excel functions (e.g., an =FDS code can be divided by or added to another cell) +

Basic Syntax

=FDS(“IDENTIFIER”,”FORMULA(START_DATE,END_DATE,FREQUENCY)”)

The code is composed of two distinct parts: the identifier of the company or index of interest and the formula of the item being retrieved.  Both of these items  +
are enclosed in quotation marks.
You can write the identifier as an Exchange Ticker, such as XOM for Exxon Mobile Corporation or a SEDOL, such as 079805 for BP PLC.  +
Note:  SEDOL stands for Stock Exchange Daily Official List.
This syntax is the basic syntax for creating an =FDS code, but the arguments will vary based on the formula you select.  For example, not all formulas include  +
a start date, end date, and frequency.

=FDS(“XOM”,”P_PRICE(0D)”)

Examples

To retrieve the latest closing price for Exxon Mobile Corporation, the =FDS code is:

=FDS(“079805”,”FG_SALES(0)”)

To retrieve the latest annual sales value for BP PLC using the FactSet Global library, the =FDS code is:

The following are benefits to building models with =FDS codes:
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Dates

Frequency Options

Examples of Absolute Dates * Examples of Relative Dates

Day: 7/11/1997, 1/1/2003, 3/6/2008 Most recent trading day: 0D 

Month-end: 6/1998, 4/2003, 11/2006, 5/2008 One trading day prior to the most recent trading day: -1D

Fiscal quarter-end: 99/1F, 2005/3F, 2008/2F Seven days prior to the most recent trading day: -1AW

Calendar quarter-end: 1999/1C, 2005/3C, 08/2C Last trading day of the most recent week: 0W

Semiannual period-end: 2002/1S, 2002/2S, 2003/1S Last trading day three weeks ago: -2W

Fiscal year-end: 1999, 2005, 07 One month ago from the most recent trading day: -1AM

* When using an absolute date in a FactSet formula, 
always enter the date in the format: MM/DD/YYYY.

Last trading day twelve months ago: -11M 
 
Last trading day of the most recent fiscal year: 0Y

D      Daily AM    Actual Monthly Y                 Fiscal Yearly

W     Weekly Q       Fiscal Quarterly CY               Calendar Yearly

AW   Actual Weekly CQ     Calendar Quarterly AY               Actual Yearly

M     Monthly AQ     Actual Quarterly RANGE        Range between two dates

=FDS codes accept both relative and absolute dates as formula arguments.  An absolute date is a specific point in time, while a relative date represents a date relative to the most 
recently updated period.

Tip:  You can also mix absolute and relative dates using FactSet formulas.  For example, entering 12/31/2009-2AW returns data as of two actual weeks (14 days) before the end of 2009.
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To find a formula, type a 
keyword and click Search.

Click the Star icon to bookmark 
a formula as a “favorite.” To 
search for formulas within your 
Favorites, select “Favorites” 
from the Sources drop-down 
menu.

To narrow your search, select a 
database from the Sources drop-
down menu. Select the FactSet 
Recommended library to access 
the most commonly requested 
and frequently used formulas 
across all data sources.

Click the Information button to 
see additional details about the 
database source, such as the 
type of data available.

Navigating New Formula Lookup
To add formulas using the new version of Formula Lookup: 
1.     In Microsoft Excel 2007, go to FactSet > Insert Formula > Formula Lookup to launch Formula Lookup. 
2.     Search for the formula and specify the formula arguments, such as dates and currency.
3.     Click Add Selected to preview the data that you’ve selected.  
4.     Click OK to add the formula to your spreadsheet.

Formula Lookup 2.0 makes it easy to incorporate FactSet data into your models and reports by helping you find formulas and build =FDS codes.  For a guided tour of how to use Formula 
Lookup, launch the eLearning courses from Online Assistant page 15972.

View the most commonly 
requested formulas throughout 
Formula Lookup, denoted by 
the       icon.

Click the Cell Picker button 
to cell reference the identifier 
and/or formula arguments, such 
as start date.  You can also type 
the cell reference directly in the 
argument box using the format, 
=cell_address (e.g., =A1).
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Filings Wizard lets you quickly insert EDGAR 10K and 10Q tables into Microsoft Excel and reference those tables in the EDGAR filing.  To access the Filings Wizard utility in Microsoft Excel, 
go to the FactSet tab > Filings Wizard button.

Enter a ticker or click the Lookup 
button to find your identifier.

Select multiple identifiers by 
referencing your identifier list from 
a Microsoft Excel report.

Select the check boxes to indicate 
which documents you want to 
search for.

Use the Destination drop-down 
menu to specify the destination 
for the tables. With the option 
“Separate sheets in New Workbook” 
selected, each document table is 
downloaded to a separate sheet in 
the workbook.

To view the complete filing, click a 
hyperlinked report in the spreadsheet.

Click the OK button to 
download the tables.



Using Spreadsheet Tools

(61)support@factset.com Copyright © 2010 FactSet Research Systems Inc. All rights reserved.

15415

Online Assistant Page ID

FactSet’s Productivity Suite offers a Microsoft Excel add-in designed to significantly reduce the time required to create, format, and audit Excel spreadsheets via over 100 customizable 
tools.  Open the Examples Workbook to practice using all the spreadsheet tools by choosing the FactSet tab > Help > Spreadsheet Tools Examples Workbook.

AutoColor
Automatically color-code cell entries as you type them to differentiate between inputs, 
formulas, and links. You can set the colors for each category in Spreadsheet Tools User 
Settings (Settings > Spreadsheet Tools). 

AutoColor a selection:     + CTRL+ALT+A
AutoColor a whole worksheet:    + CTRL+ALT+S

Auditing
Quickly reveal a cell’s precedents or dependents. Smart Precedents and Smart 
Dependents combine native Excel features with the ability to audit multiple cells at a time 
and across multiple workbooks.

Trace a cell’s precedents:    + CTRL+SHIFT+{
Trace a cell’s dependents:    + CTRL+SHIFT+}

Smart Copy
Copy inputs and formulas across a range using a single keystroke without selecting the 
desired target range.  Smart Copy intelligently determines the appropriate target range 
and will adjust formulas automatically if there are irregularly spaced columns.

Smart Copy Right:    + CTRL+SHIFT+R
Smart Copy Down:    + CTRL+SHIFT+D

Formatting SmartCycles
Cycle through up to 10 customizable styles of a given category and choose these from up 
to 20 Style and Color SmartCycles that you create.  

Common SmartCycles:
Currency    + CTRL+SHIFT+$
Date     + CTRL+SHIFT+@ 
Percent    + CTRL+SHIFT+%
Multiple    + CTRL+SHIFT+*
Font Color    + CTRL+ALT+Z
Underline    + CTRL+SHIFT+U
Centering    + CTRL+SHIFT+C
Borders    + CTRL+SHIFT+B
Increase Decimal   + CTRL+,
Decrease Decimal   + CTRL+.

Check for Errors
Toggle your own custom replacement error message (e.g., NA) to appear in place of an 
Excel error message (e.g., #DIV/0).   To create a custom error message, open the User 
Settings dialog box and choose the General tab.

If you set your message to the number zero (0), then other cells can still reference the 
cell without the error carrying through the entire spreadsheet.

Toggle custom error message:   + CTRL+SHIFT+E

Hot Key Manager
See all the Spreadsheet Tools’ functions and their assigned Hot Keys, function name, 
category, priority, or application in the Hot Key Manager by selecting Settings > Manage 
Hot Keys.  Here you can edit the key combination that triggers each feature and share 
your Hot Key settings with other users. 
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Modeling Tools significantly reduces the time you spend creating and auditing Microsoft Excel spreadsheets.  To practice using all the tools, choose the FactSet tab > Help > Modeling 
Tools Examples Workbook.  To see a guided tour introducing you to Modeling Tools, launch the eLearning demo on Online Assistant page 16170.  

Add Growth and Other Drivers

Allows you to forecast an existing line item based on 
its growth projections. 

Select the cell range (they need not be contiguous, but 
they must be in the same row and have a row label 
such as “Sales” or “Revenue”) and then

Modeling Tools button > Add Driver/Buildup

You can also drive a sales item based on growth, insert a lookup table for an existing item, 
and more using the following tools:

Add Ratio Driver - forecasts an existing line item based on projections of its proportion to  +
another line item
Add Price * Volume Buildup - forecasts an existing sales line item based on projections of  +
the price of one or more goods and the volume sold of each of those goods
Add Market Size * Market Share Buildup - forecasts an existing sales line item based on  +
projections of the total market size of an industry or product line and the market share 
captured by a given company or business unit
Add Other Product Buildup +  - forecasts an existing line item based on projections of two 
other line items that can be multiplied together to result in the original line item

Summarizing Data
Modeling Tools button > “Insert” Options
Summarizing tools allow you to quickly summarize a sum formula or insert a CAGR formula 
to summarize a line item’s trend.  

Insert Sum Summary - presents a summary of the components of the total +
Insert Contribution Analysis - inserts a contribution analysis below a line item that is  +
a sum of other line items
Insert CAGR - inserts a CAGR formula for an existing line item or series +
Convert CAGR - inserts a formula to convert an existing CAGR to a new CAGR based on  +
a different time period

Copying

Allows you to copy an analysis piece several times and total the copies into the original 
analysis.  For example, you can use a given spreadsheet to analyze each of 20 stores in a 
chain and total them up into a summary with the same structure.

Modeling Tools button > Replicate Module

FactSet Formula Translator

Make cell formulas easier to read and understand by replacing cell references with line 
item labels (when available).  For example, the Formula Translator could present “B8=B4-
B6” as “Gross Profit = Sales - COGS”.  

The Formula Bar also allows you to navigate back and forth across a cell’s  
precedents and to edit a cell’s formula.

Modeling Tools button > Formula Translator

AutoColor on Entry
Modeling Tools button > AutoColor > AutoColor on Entry

Automatically color-codes cell entries as you type to differentiate inputs, formulas, 
and links.  

AutoColor on Entry automatically colors:
Inputs +
Formulas +
Partial Inputs +
Worksheet Links +
Workbook Links +
Hyperlink + s

You can set the colors for each category in the Modeling Tools - Options  
dialog box (Settings > Modeling Tools).  

follow the clickpath.
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Use ActiveGraph to create easy-to-update, pitchbook-ready financial graphs using your firm’s corporate colors, fonts, and standards.  To launch ActiveGraph in Microsoft Word, 
PowerPoint, and Excel 2007, go to FactSet > ActiveGraph > Insert ActiveGraph.

Enter an identifier(s) here or 
search for one using the Lookup 
button.

Click the Data button to modify 
the data behind the graph, or to 
add your own data to the graph.

A real-time preview of your graph 
appears in the top pane. Right-click 
and select Format to change the 
graph’s colors, titles, legend, or axes.

Select a time period and frequency 
for the graph.  (For some graphs, 
you may also need to specify 
additional options.)

Click the Help button for detailed 
assistance.

Select a graph category and type 
(Price, Valuation, Estimates, etc.) 
by clicking the Charts button.

Click Save to create a library of 
custom charts to share with your 
colleagues.

Click OK to insert the graph into 
your Word, PowerPoint, or Excel 
document.

To add dynamic annotations, 
select a check box for each 
annotation type you’d like to show 
in your chart.  You can also add 
custom annotations by clicking the 
More button.
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Presentation Linking and Formatting enables you to send updateable Microsoft Excel-driven tables, text, pictures, and charts to PowerPoint and Word.  For a guided tour of FactSet’s 
Productivity Suite, launch the eLearning series on Online Assistant page 16170.

Creating a Presentation in PowerPoint
1.  Insert a new, custom presentation by clicking the New Presentation button.    
2.  Click the Insert Slides button, select the slide format you want, and click Insert.   
      
     Optional - Import and link standard slide content (e.g., bios, case studies,   
     league tables) by clicking the Browse button on the Insert Slides dialog box.   

Exporting Excel Data
When exporting data, first select in PowerPoint a location for the exported data  
to appear.  In Excel, all exporting options appear in the Export Data section of the  
FactSet tab, grouped by destination application.  

Table as Picture +  - Exports data from a group of selected contiguous cells
Table as Word Table +  - Exports the selected table as an embedded Word table
Table as MS Graph Chart (PowerPoint only) +  - Exports the selected table  
as a Microsoft graph
Chart as Picture +  - Exports the selected chart
Cell as Text +  - Exports data from the selected cell as updatable text

If the data in your Excel file changes, you can update your linked items in  
PowerPoint and Word by right-clicking them and selecting “Refresh Excel Links”.

Update multiple items by clicking Manage Links > Manage Excel Links.   
Click the Select All button and then Update.

Updating Linked Items

Switching Source Files
If you link to a file (e.g., Model1.xls) and then save a version of that file with  
another name, you can change the linked source to the new file since both files  
have the same named ranges.

To switch your source file:
1. Open the new source Excel file.
2. In PowerPoint, click Manage Links > Manage Excel Links.
3. Choose the Filters tab and select the original file from the Source File  
    drop-down menu.
4. Choose the Source Data tab, click Select All, and then click Edit.
5. In the Source File drop-down, select your new file.  Click OK.

Switching Source Files Automatically

1. In the FactSet tab in Excel, click Settings > Presentation Linking and Formatting.   
    In the General tab, select all three options in the Link Healing Tools section.
2. Import data from an Excel file.
3. Save the Excel file to preserve the link information, then close it and move it to 
    another location.
4. Open the file from its new location.
5. Click Refresh > Selected (or All) Excel Links.
6. You will see a prompt asking if you want to update from the open file which  
    has the same name but a different file path.

To switch the source to a file with the same name but a different path:

PowerPoint 2007 ribbon

Excel 2007 ribbon


